Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

Permit: Date:

Development: Stormwater

Inspector: Location:

» The Texas Pollutant Discharge Elimination System (TPDES) Construction General Permit (CGP) to the

maximum extent possible all discharges of storm water from the project site be composed entirely of storm water — no

sediments, hazardous materials, petroleum products, litter, construction debris, etc. shall be discharged to surface
waters in the state, waters of the United States, and a permitted Municipal Separate Storm Water Sewer System.

A. Large Construction Project

» Is this a Large Construction Project? That is, a construction activity including clearing, grading,

and excavating that results in disturbance of equal to or greater than 5 acres of land. O Yes O No
Large construction activities also include the disturbance of less than 5 acres of land that is a O N/A
part of a common plan of development if the larger common plan will ultimately disturb
equal to or greater than feet acres of land.
B. Small Construction Project
» Is this a Small Construction Project? That is, a construction activity including clearing, grading,
and excavating that results in disturbance of equal to or greater than 1 acre of land and less than 5 O Yes O No
acres of land. aN/A
Small construction activities also include the disturbance of less than 1 acre of land that is a
part of a common plan of development if the larger common plan will ultimately disturb
equal to or greater than 1 acre of land.
C. Projects Less Than One Acre in Size
» Is this project less than 1 acre in size (and is not a part of a larger, common develop that will O Yes O No
ultimately disturb an area greater than 1 acre)? O N/A
If so, TXDOT requires we have a SW3P appropriate to the project.
D. Permit Review
» Does the construction site qualify for a Texas Pollutant Discharge Elimination System (TPDES) O Yes O<1
permit — that is, is it a Large or Small Construction Project? (if not, it must be less than 1 acre in size) acre
E. Notice of Intent (NOI) to Discharge Storm Water from a Construction Site — When to File
» Is the project a Large Construction Project? If so, a NOI must be submitted to the Texas O Yes O No
Commission on Environmental Quality (TCEQ) along with required payment. 0O N/A
» Is the project a Small Construction Project? If so, a NOI is not required. O Yes O No
O N/A
» Will the project discharge water to a permitted Municipal Separate Storm Water Sewer System O Yes O No
(City of Donna streets, gutters, right-of-way, drainage easements, storm drains, playa lakes)? aN/A
if s0, has a copy of the NOI (or Construction Site Notice, if it is a Small Construction O Ves o No
project) been forwarded to the City of Donna?
O N/A
F. Notice of Intent (NOI) to Discharge Storm Water from a Construction Site — Contents (for
Large Construction Projects only)
» Does the NOI contain the name, address, and telephone number of the operator filing the NOI? O Yes O No
O N/A
» Does the NOI contain the name (any other identifiers), address, county, and latitude / longitude of O Yes O No
the of the construction project? O N/A
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

» Does the NOI contain conformation that a SW3P has been developed and that the SW3P will be O Yes O No

compliant with any applicable local sediment and erosion control plans? O N/A

» Does the NOI contain the name of the receiving waters? O Yes O No
O N/A

G. Does the TPDES Construction Site Notice contain the following information?

» The TPDES Permit number? (If you do not currently have a permit number, post the Construction 0 Yes 0 No

Site Notice and as soon as the permit number arrives add the permit number to the notice.) o N/A

» The name and telephone number of the local contact person? O Yes O No

» A brief description of the project? O Yes O No
Does this description include an estimated start date and projected end date or the date that O Yes O No

disturbed soils will be stabilized?

» The location of the Storm Water Pollution Prevention Plan (SW3P)? O Yes O No

» Is the Construction Site Notice for Large Construction Activities posted? O Yes O No
O N/A

» Is the Construction Site Notice for Small Construction Activities posted — the area engineer must O Yes O No

sign this form? O N/A

H. Bulletin Board — Posting Requirements

» DOES the project bulletin board contain the Construction Site Notice? (all projects must have the O Yes 0O No
Construction Site Notice posted regardless of the size [large or small] of the project)

» Does the project bulletin board contain the NOI? (for Large Construction Projects only) O Yes O No
O N/A

» Does the project bulletin board contain the TCEQ permit? (for Large Construction Projects only) O Yes O No
O N/A

I. Bulletin Board — Other Requirements

» 15 the CGP Construction Site Notice posted near the entrance to the project—on the project or 0O Yes 0O No
SW3P bulletin board?

» Is the Construction Site Notice posted on-site even if there is not a field office? O Yes O No
O N/A
» Was the Construction Site Notice posted prior to the start of construction? O Yes O No

J. Signature Authority

» Is the “Signature Authority and Delegation” in the SW3P? O Yes O No
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

K. General Conditions

» Does the facility have adequate storm water controls—have the BMPs been evaluated on-site for O Yes O No

effectiveness)?

» Are silt fences or equivalent sediment controls used for all side-slope and down-slope boundaries of | O Yes O No

the construction area?

L. Are there control measures to:

» Prevent off-site tracking of mud and solvents? O Yes O No
O N/A

» Minimize dust generation? O Yes O No
O N/A

» Prevent discharges of solids and building materials? O Yes O No
O N/A

M. Storm Water Pollution Prevention Plan (SW3P) — Deadlines

» Was the SW3P completed prior to obtaining authorization to discharge storm water under the 0O Yes 0 No

TPDES Construction General Permit?

» Was the SW3P implemented prior to the start of construction activities that result in soil disturbing | O Yes O No

activities?

N. Storm Water Pollution Prevention Plan (SW3P) — Location

» Is a copy of the SW3P on-site at the facility that generates storm water discharges (the construction | O Yes O No

site field office)? o N/A

» If the SW3P is not on-site is a Construction Site Notice on-site and does the Construction Site 0O Yes 0 No

Notice state the location of the SW3P? 0 N/A

O. Storm Water Pollution Prevention Plan

» Does the SW3P contain a description of the nature of the construction activity? O Yes O No

» Does the SW3P contain a description of potential project pollutants? O Yes O No

» Does the SW3P contain a description of potential project pollutant sources? O Yes O No

» Does the SW3P contain a description of the intended schedule or sequence of major activities that O Yes O No

will disturb soils for major portions of the site?

» Does the SW3P contain the number of acres of the entire construction site property and the total

number of acres of the site where disturbed soils will occur? O Yes O No

Do these totals include off-site material storage areas, overburden and stockpiles of dirt, and | O Yes O No

borrow areas?
o Note: Does the SW3P note that Project Specific Locations (PSLs) (e.g., field offices,

LRGYV TPDES Stormwater Task, Force Page 3 of 6 April 2008

*This form is currently beina revised.



Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

material storage areas, overburden and stockpiles of dirt, borrow sites) beyond the project

right-of-way have “individual operator” status under the TPDES Construction General O Yes 0 No
Permit and that the SW3Ps for those “PSLs beyond the right-of-way are the responsibility of O N/A
the project contractor.”
oNote: Once all off-site PSLs have been established by the contractor, the SW3P must be O Yes O No
revised to show or describe the locations of the off-site PSLs and the responsible operator.
. O N/A
Has this been done?
» Does the SW3P contain a map showing the general location of the construction site? O Yes O No
» Does the SW3P include a detailed map indicating the following:
o drainage patterns and approximate slopes anticipated after major grading activities? O Yes O No
o areas where soil disturbance will occur? O Yes O No
o locations of all major structural controls either planned or in-place? O Yes O No
o locations where stabilization practices are expected to be used? O Yes O No
o locations of off-site material, waste, borrow, equipment storage areas, asphalt and concrete | O Yes O No
plants, or any other Project Specific Locations within one mile of the project that provide O N/A
support to the construction site within one mile of the project?
o the location of surface waters (including wetlands) either adjacent to or in close proximity | O Yes O No
to the project? 0 N/A
o the locations where storm water discharges from the site directly to a surface water body? | O Yes O No
O N/A
» Does the SW3P contain the names of receiving waters at or near the project that will be disturbed or | O Yes O No
will receive discharges from disturbed areas of the project? o N/A
» Does the SW3P contain a copy of the TPDES Construction General Permit? O Yes O No
P. Duty to Keep Current
» If there is a change of design, construction, operation, or maintenance that has a significant effect on
the discharge of pollutants that has not previously been addressed in the SW3P the SW3P must be O Yes 0 No
amended to reflect this change — has this been done? o N/A
» Do inspections or investigations indicate the SW3P is ineffective in eliminating or significantly
minimizing pollutants from the construction site? O Yes O No
» Do inspections or investigations indicate the SW3P is not achieving the general objectives of
controlling pollutants? O Yes O No
» If through inspections, it is determined that best management practices are not operating effectively,
maintenance must be performed before the next anticipated storm event or as necessary to maintain 0 Yes 0 No

the effectiveness of storm water controls — is this being done?

Q. Inspection of Controls

» Are inspectors familiar with the SW3P inspecting the following locations every seven days?
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

Disturbed areas of the construction site that have not been finally stabilized?
Avreas used for storage of materials that are exposed to precipitation?
Structural control measures?

Locations where vehicles exit the site?

» Are inspectors familiar with the SW3P inspecting accessible discharge locations to determine if
erosion control measures are effective in preventing visually noticeable changes to the receiving
waiters? (The frequency of these inspections must be established by the district in the SW3P with
consideration for local rainfall and soils.)
To the maximum extent practicable, where discharge locations are inaccessible, are
inspectors inspecting nearby downstream locations (this inspection must occur at least once
during the construction activity if a discharge occurs)?

» Based on the results of inspections, is the SW3P being modified to better control pollutants in
runoff?

Avre revisions to the SW3P being completed within seven calendar days following the
inspection.

If existing best management practices are modified or additional best management practices
are necessary, an implementation schedule must be described in the SW3P. Wherever
possible, those changes must be implemented before the next storm event—is this being
done?

If implementation before the next storm event is impracticable, are needed changes being
implemented as soon as practicable?

» Are the names and qualifications of the inspectors retained as a part of the SW3P?

» Has a report summarizing the scope of the inspection, the dates of inspections, and major
observations relating to the implementation of the SW3P been completed and retained as a part of the
SW3P?

» Major observations should include:

o the locations of discharges of sediments or other pollutants from the site
o the locations of best management practices that need to be maintained

o the location of best management practices that failed to operate as designed or proved
inadequate for a particular location

o the locations where additional best management practices are needed

» Reports must identify incidents of non-compliance — is this being done?

» Where a report does not identify any incidents of non-compliance, the report must contain a
certification that the facility or site is in compliance with the SW3P and this permit.
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Checklist for Construction Site SW3P Inspection
Texas Pollutant Discharge Elimination System Construction General Permit*

» Has the inspection report been signed by the contractor’s representative? O Yes O No
» Has the inspection report been signed by the project inspector? O Yes O No
» Has the inspection report and the certification statement been signed by the area engineer, assistant | O Yes O No
area engineer, project engineer or chief project inspector?
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